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Tips for iMovie 

Moving Video to Your Mac 

• iMovie automatically detects your camcorder 
o iMovie will automatically detect when you have a FireWire camcorder 

connected. If you see the message No Camera Attached, make sure 
your camera is turned on and properly plugged in to your computer via a 
FireWire cable and that your camcorder is set to VCR, VTR, or Play 
mode. You can also click the Connection Help button for more 
suggestions. 

• iMovie supports different video formats 
o When you create your project, choose the appropriate video format 

depending on your needs. For importing video from your camcorder, 
choose between DV, DV Widescreen, HDV 1080i, and HDV 720i. For 
recording from your iSight, select iSight. If you will be copying MPEG-4 
files from your PDA or phone, select MPEG-4. 

• Import directly to the iMovie timeline 
o You can import footage directly from your camcorder to the iMovie 

timeline rather than to the Clips pane. This is a quick and easy way to 
get your footage into your iMovie project. You can then edit right in the 
timeline. From the iMovie menu, choose Preferences, click Import, and 
then choose the option Place clips in Movie Timeline. 

• If you’re importing video that is already edited 
o Instead of importing your video as separate clips, you can set iMovie to 

import your video as a single clip. This may be useful if you’re importing 
a movie that you’ve already edited and you just want to change a small 
portion. From the iMovie menu, choose Preferences, click Import, and 
then deselect the "Start a new clip at each scene break" option. If you 
prefer, select "Limit scene length to" and set a limit for the number of 
minutes. This will ensure your imported files don’t get too large, in case 
you’ll be copying clips between iMovie projects. 

• What you need to make a high-definition video with iMovie 
o High definition video is quickly becoming the format you see broadcast 

on TV. An HD camcorder stores more pixels than a standard camcorder, 
letting you see more detail in your video footage. iMovie supports 
importing and editing video from HD camcorders (HDV 720p and 1080i), 
so you can make movies just like the pros—and it’s a great way to 
archive your most  precious life events in the highest resolution possible 
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• Using video from an MPEG-4 camera 
o Many digital still cameras, PDAs, and mobile phones let you record short 

videos in the MPEG-4 format, a standard compression that is used to 
significantly reduce the file size of video. While iMovie doesn't know how 
to import video from these devices directly, as it does with FireWire 
devices, you can still use the MPEG-4 files once you've copied them to 
your Mac. Just drag them into the iMovie Clips pane using the Finder or 
import them using Import from the File menu. 

• Using video from your connected or built-in iSight camera 
o You can use your iSight camera to record video directly into your iMovie 

project. This means you can spontaneously add clips to your project 
while you’re working on it. Just connect your iSight camera to the 
FireWire port of your Mac and you’re ready to start recording. If you have 
more then one camcorder connected, such as an iSight and a 
camcorder,—or you have an iMac with a built-in iSight—choose iSight 
from the pop-up menu that appears when you switch to camera mode. 

• Monitor the amount of hard disk space remaining 
o Digital video clips use a large amount of hard disk space. For example, 

five minutes of DV footage uses approximately 1GB of space. The same 
amount of HD video can occupy between 2GB to 4GB, depending on the 
format and footage. To save hard disk space, import and edit your video 
in sections instead of trying to do so all at once. You can see how much 
space remains on your hard disk by using the monitor located in the 
lower-right corner of the iMovie window. 

Arranging Your Clips 

• Decide the story your movie will tell 
o When creating your movie, think about the story you want your movie to 

tell. Is it meant to entertain, inform, or persuade your audience? As you 
decide which clips to include and where to include them, always ask 
yourself, will this help tell my story best. 

• Carefully consider how you arrange your clips 
o When creating your movie, think about how you want to arrange your 

clips. Consider mixing wide shots with close-ups; adding a shot that sets 
the location (known as an establishing shot) before showing close-ups; 
and including similar shots at the beginning and end of your movie, 
which provides a sense of closure. Be creative and have fun—your 
audience will appreciate it. 
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• Easily move clips around 
o There are a few different ways you can move clips around in iMovie. You 

can drag imported clips from the Clips pane to the timeline or drag and 
rearrange clips within the timeline itself. You can even open multiple 
iMovie projects and copy clips between them, too. To select and move 
multiple clips, hold down the Command key while selecting individual 
clips, or hold down the Shift key to select a range of clips. 

• Split a clip into multiple clips 
o If you have a really long clip with no scene break, and you want to break 

it into several sections, it’s easy to create multiple clips. Just move the 
play head to where you want to split the clip, and then choose Split 
Video Clip at Play head from the Edit menu. 

• Delete clips you don’t want to use 
o After you decide which clips you want to use in your iMovie project, you 

might want to delete any unused clips. This helps keep your project 
organized and reclaim hard disk space. To delete unused clips drag 
them to the iMovie trash, or select the clips and press the Delete key. 
The clips stay in the iMovie trash, and can be retrieved, until you empty 
the trash. To retrieve a clip from the iMovie trash, simply open the trash 
and drag the clip back to your project. 

• See when a clip was recorded 
o You can see when a clip was recorded to help if you’re arranging clips 

chronologically. Double-click a clip to open the Clip Info window. Besides 
the size and duration of your clip, you’ll see the date it was captured. 

• Compare the lengths of your movie’s clips 
o To view a clip’s length relative to the length of other clips in the movie, 

click the Timeline Viewer button in the iMovie window. The clips appear 
as long narrow boxes along with the tracks for any music you’ve added. 
You can use the Zoom slider in this view to see more or less of your 
clips in the window. 
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Trimming Your Clips 

• Easily undo changes you made 
o You want to work fluidly with your footage to create a great movie. 

Sometimes you might make a few edits and decide you don’t like them. 
With iMovie you can undo as many changes as you want. Simply choose 
Undo from the Edit menu as many times as you want between saves. 

• Trimmed portions of clips are never deleted 
o When you use direct trimming, the unused portion of your clip is simply 

rolled up underneath your clip. You can always unroll the footage back 
out if you change your mind about which footage you want to use. You 
can also choose Revert Clip to Original from the advanced menu. 

• Cropping and deleting portions of a clip 
o Besides direct trimming, you can select precisely which parts of your 

clips you want to show in your movie by using Crop or Clear. Select a 
portion of a clip in the clip viewer by dragging the crop markers below 
the scrubber bar to indicate where you want your clip to begin and end. 
Next, go to the Edit menu and choose Crop or Clear to remove a 
section. You can use the arrow keys on your keyboard to move frame by 
frame through your footage, or hold down the Shift key while pressing 
the arrow key to move ten frames at a time. 

• Change two clips at once 
o You can use a roll edit to edit the ending point of one clip and the 

beginning point of the next clip. A roll edit adjusts the out point and in 
point of two adjacent clips simultaneously. If you like where two clips are 
placed in the timeline, but you want to change when the cut point 
happens, you can use the Roll tool. Hold down the Command key as you 
drag from the center of one clip toward the next clip, effectively trimming 
the adjacent clip. No clips move in the Timeline as a result; only the edit 
point between the two clips moves. 

• View waveforms when you use direct trimming with audio 
o When you want to be precise with your audio editing in the timeline, go 

to the View menu and choose Show Audio Waveforms. Select an audio 
clip and use the Up and Down Arrow keys to enlarge or shrink the view 
of the waveforms. This way, when you edit in the timeline you can see 
exactly where your sound starts and stops, and even see where the 
beats occur. 
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• Ripple your clips down the timeline 
o In the timeline view, position your pointer in the center of a clip, and then 

click and drag your mouse to the right. All of the clips in the timeline, 
beginning with the clip you selected, move to the right, leaving a gap in 
the timeline. You can fill this gap with another clip, a photo, or even a 
title. 

• Add color clips in your movie 
o With iMovie, you can create clips in the timeline that don’t contain video 

footage, but fill the frame with black or another color. This can help you 
create interesting transitions and give you dramatic backgrounds for 
titles. In the timeline, simply drag a clip from the center to the right to 
insert space before your clip. Switch to Clip view and notice a black clip 
appears before your selected clip. To change the color, just double-click 
the clip. In the window that appears, you can set the clip’s color and 
duration. 

 

Playing Your New Movie 

• Using the keyboard 
o You can use the Left and Right Arrow keys to move a single frame at a 

time or hold the arrow keys down to play forwards and backwards. Hold 
the Shift key while pressing the arrow keys to move ten frames at a time. 
Press the Home key to move to the start of your movie. 

• Anticipate upcoming edit points 
o As you preview your movie, get in the habit of watching the playhead to 

tell where you are in the timeline. This will help you anticipate upcoming 
edits, such as the start of a new clip or a transition. You’ll find you use 
this technique a lot when deciding where to place an edit or polishing off 
the final version of your movie. 
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Adding Polish with iMovie Themes 

• Different theme elements to choose from 
o iMovie includes five theme styles: Travel, Road Trip, Pass Through, 

Reflection - White, and Reflection - Black.  Each theme style includes 
various theme elements, such as Open, Chapter, Bumper, Lower Third, 
and Credits.  Theme elements have associated places to be used 
throughout a movie, although ultimately where you decide to use a 
theme element is up to your personal style.  

• Where to use the Open theme element 
o The Open theme element is great for the opening of your movie. It 

includes a place to display your movie title, along with a drop zone for 
one or more scenes from your movie. 

• Where to use the Chapter theme element 
o The Chapter theme element is great for the beginning of a new chapter 

or new section of your video.  It includes a place to display your chapter 
title. 

• Where to use the Bumper theme element 
o The Bumper theme element is typically used to segue between two 

sections of your movie or a movie scene and a break. Bumper elements 
typically include multiple drop zones and may or may not include a place 
for a title. Bumpers are typically seen on a news or documentary show 
before or after going to commercial, as a way to keep viewers interested 
in what’s coming up after the break. 

• Where to use the Lower Thirds theme element 
o The Lower Thirds theme element is used to display to a title or graphic 

that appears over a single video clip, using the lower third of the screen. 
It is often used in documentaries or news segments to introduce text to a 
given video clip, such as the name of a person or location just 
introduced.  Many times lower thirds includes motion and text to add 
pizzazz when introducing viewers to something new. 

• Where to use the Credits theme element 
o The Credits theme element is used at the end of a movie, to display 

credits or a list of names associated with the movie just shown. 
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• Coordinate iMovie themes and iDVD themes 
o All five iMovie themes have corresponding themes in iDVD. You may 

decide to coordinate your projects by using the same themes in your 
movies as on your DVD menus.  You’ll even find some iPhoto themes 
and books have similar theme styles. 

• Creating custom movies for your drop zones 
o Instead of dropping your existing photos or movie clips into a theme drop 

zone, you may decide to create a custom movie clip to be used in a drop 
zone. This way, you have more control over exactly what gets played 
from a drop zone. Keep in mind that drop zones in movie themes are 
usually only displayed for a few seconds. 
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Adding Photos 

• Organize your pictures ahead of time 
o If you plan to include lots of digital pictures in your movie, you may want 

to organize them first. In iPhoto, create a new album, and then add the 
pictures in the order in which you want them to appear in your movie. 

• Make a still image from a video clip 
o You may have a poor-quality video clip that contains one great image. 

With iMovie, you can easily turn any frame of a video clip into a still 
image to use in your movie. Simply move the playhead to the image in 
the clip, and choose Create Still Frame from the Edit menu. Your new 
still clip appears in the Clips pane. If you want to adjust its length, 
double-click the clip to open the Clip Info window and enter a new length 
for your still image. 

• Change the length of a still image 
o The method for changing the length of an image in your movie depends 

if it is a still image or has the Ken Burns effect applied. For a still image, 
double-click the clip to open the Clip Info window and enter a new length 
for your still image. For an image with the Ken Burns effect applied, 
select the image, then adjust the duration slider at the bottom of the 
Photo Settings pane, and click Apply. Of course you can also edit any 
clip directly in the timeline by choosing the Split Video Clip at Playhead 
from the Edit menu. 

• Drag photos directly from iPhoto into the iMovie clips pane 
o You can also search your iPhoto Library from within iPhoto to find just 

the right picture for your movie. When you locate the picture you want, 
drag it from iPhoto to the iMovie Clips pane or the timeline. 

• Importing video clips you took using your digital camera 
o Many digital cameras let you take short video clips. This can be useful if 

you’re at an event without your camcorder. When you import your photos 
into iPhoto, these movies will also become part of your Photo Library. 
You can then drag these movie clips to your iMovie project and edit 
them, just like the footage you take with your camcorder. 

• Use the Ken Burns Effect in iMovie to crop your pictures to match 
your widescreen footage 

o Within iMovie, when your project is set as HDV or DV Widescreen, the 
Photos pane is pre-set for 16:9 aspect ratios, allowing you to crop a 
photo to the same aspect ratio of your video footage. 
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• Use iPhoto to resize your digital pictures to match your HD video 
footage 

o If you’re editing your pictures in iPhoto, for use with an HDV or DV 
widescreen iMovie project, go to Edit mode, and then choose 16 x 9 
(HD) from the Constrain pop-up menu in the bottom toolbar. This will 
constrain the crop tool to a 16:9 ratio—the same used in your video 
footage. This way, you can take advantage of the great editing tools in 
iPhoto. 

• Scanning your old photographs 
o You’re not limited to using only digital photos in your movie. Consider 

scanning your old pictures and including them. For example, you could 
scan your parents’ wedding pictures to use in a video you make for their 
wedding anniversary. 
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Adding a Soundtrack 

• Sample different songs with your video 
o It’s amazing how much impact a soundtrack will add to a movie or 

montage. Sample different songs with your footage to see how different 
music can affect the mood of your iMovie project. 

• Preview your movie with or without music 
o When playing your movie, you can isolate which audio tracks you want 

to hear. Use the checkboxes at the far right side of the timeline viewer to 
turn the three music tracks on and off. The top checkbox controls the 
audio included with your video clip. 

• Find your iTunes music quickly and easily 
o If you have a large iTunes Library, you can access specific iTunes 

playlists from the Audio pane. You can also select a playlist or your 
library and type the name of a song in the Search field. As you type, 
you’ll see your list of music shorten to match what you’re typing. 

• Check the iTunes Music Store for ideas 
o Look in the iTunes Essentials section of the iTunes Music Store to find a 

nice variety of musical styles and genres. If you know you want a song 
that contains certain words, try an Advanced Search of the Music Store 
to see what new ideas for music you can come up with. 

• Drag songs directly from iTunes 
o Rather than accessing your music from the iLife Media Browser in 

iMovie, you can search your music library right in iTunes to find just the 
song you’re looking for, and then drag it your movie project’s timeline. 

• Lock audio to a clip 
o You can ensure a sound effect or any audio clip stays in sync with a 

point in your video by locking it to the video clip. This is especially helpful 
in the early stages of editing your movie when you are still moving many 
clips around. To lock an audio clip to a video clip, move the playhead to 
the point in your audio clip you want to lock and choose Lock Audio Clip 
at Playhead from the advanced menu. You’ll see two yellow push-pins 
added to your clips to indicate they are "pinned" together. 

• Add sound effects 
o iMovie comes with Skywalker and standard sound effects that you can 

use to enhance your movie. If you have sound effects that you created 
yourself or purchased from a sound library, you can easily add them to 
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your iMovie sound effects list. Place the sound effect file in the Sound 
Effects folder located in the iMovie folder in the Library folder in your 
home folder. The next time you open iMovie, you’ll see the file in the list 
of sound effects. Sound effect files are either AIFF or MP3 format. 

• Use GarageBand to score your iMovie project 
o GarageBand 3 lets you score your iMovie project. To start, import your 

movie into a GarageBand project. You’ll be able to play your movie 
inside GarageBand, while creating your new soundtrack. 

Adding Narration 

• Write a script 
o To help you sound more like a pro, consider writing a script for your 

narration. You can practice this before you actually record so your voice 
sounds more relaxed and natural. 

• Using your iSight as a microphone 
o You’ve used your attached iSight camera to chat with a buddy. Why not 

take advantage of the high-quality microphone, and record your 
narration into iMovie with your iSight?  Just plug it in to the FireWire port 
on your Mac and you’re ready to record using your iSight in iMovie. 
Many Macs have a built-in iSight and microphone as well.  

• Use an external USB microphone 
o You can get high-quality voice recordings with an external USB 

microphone and your Mac. These microphones often come with 
headsets, so the microphone will be positioned very close to your mouth 
and will pick up more of your voice and less room noise. 

• Use your camcorder to record audio 
o If you don't have an external microphone available, you can also record 

narration to videotape and only use the audio portion.  Import your video 
as usual and add it to the timeline.  Highlight your video clip and choose 
Extract Audio from the Advanced menu. Your audio will be extracted 
from the video and placed on the track immediately below, locked to 
your video. To unlock audio, highlight your audio clip and choose Unlock 
Audio Clip from the advanced menu. Move the audio to the narration 
point in your video and discard the unused video clip. 
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• Take your laptop someplace quiet 
o Remember that the microphone you record with is going to pick up all 

the sound in the room. If you’re using a laptop, consider moving to a 
quiet room, close the door behind you, and shut off any other machines 
before you begin recording. 

• Don’t try to record your narration all at once 
o It’s easier to record your narration in small pieces. You’ll be able to 

position the pieces exactly where you want them in your movie, and 
you’ll have to rerecord only a small portion if you make a mistake. 

• Lock narration to a video clip 
o You can ensure a narration or any audio clip stays in sync with a point in 

your video by locking it to the video clip. This is especially helpful when 
adding narration, since narration is often associated with the specific 
video it plays with. To lock any audio clip to a video clip, move the 
playhead where you want to lock the audio and choose Lock Audio Clip 
at Playhead from the advanced menu. You’ll see two yellow push-pins 
added to your clips to indicate they are "pinned" together. 

• Lower the volume or mute the video clips’ audio 
o When you add your own narration, you may want to lower the volume of 

your audio tracks or any music you’ve added. This way, the audio won’t 
overwhelm your audience, and they will be able to hear your narration 
better. Just select the clips or music track you want to change, and then 
use the Clip volume slider to lower the volume. To only lower audio at a 
specific area in your video, use Show Clip Volume Levels from the View 
menu and edit the audio right before and after your narration plays. 
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Adding Titles 

• Use titles creatively 
o Titles are useful for more than just the beginning and ending of your 

movie. You can use a title to show the passage of time. Consider titles 
such as "Meanwhile, back at home" or "Two weeks later." You can even 
use titles to list the names of the people in your movie, which you’ll find 
helpful when you watch your movie years later. 

• Adjust the speed of a title 
o With iMovie, you can adjust how fast titles appear and how long they 

stay onscreen by using the Speed and Pause sliders in the Titles pane. 
Remember to leave your titles onscreen long enough for your audience 
to read them. 

• Changing the placement of text on screen 
o You can also get creative with where you place text on screen by 

inserting spaces and line breaks in the Music Video style. For example, 
in an interview, you might want to highlight key points as a list on the top 
right side of the screen. 

• Use multiple titles in a single clip 
o You’re not limited to a single title in a video clip, but can use multiple 

titles on the same clip. For example, you could combine a centered title 
with a subtitle. 

• Place videos and still images inside your title text 
o The Clip to Characters title feature lets you create titles with special 

effects where you can see through your titles to display animated 
gradients, motion images, video clips and more. Try varying the kind of 
footage you place behind your title. For example, use black and white 
footage, clips with lots of effects, or even still images that move out of 
the frame to discover some really interesting title effects. 
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Adding Transitions 

• Identifying the type of transition 
o The blue box listed to the left of each transition will tell you the type of 

transition it is. A single triangle facing right indicates this transition is 
applied to the beginning of a clip, such as a fade-in. A single triangle 
facing left indicates this transition is applied to the end of a clip, such as 
a wash out. Two triangles indicates the transition is applied between two 
clips, such as a cross dissolve. 

• Adjust a transition’s speed and other settings 
o You can adjust the speed of most transitions. For example, you can 

apply a quick cross dissolve between two clips or fade a clip in over 
several seconds. Use the Speed slider at the botton of the Transitions 
pane to adjust the timing, and then click the Update button. With the 
Push transition, you can adjust where the clip comes from. 

• Applying a transition to multiple clips at once 
o If you want to apply the same transition between multiple clips, select the 

clips in the timeline, then apply the transition. This adds the transition to 
all of the selected clips. To select multiple clips, hold down the 
Command key while selecting the individual clips or hold the Shift key to 
select a range of clips. 

• Fade in and out to black 
o There may be times in your movie when you want to show that you’ve 

switched to a different location or time of day. A technique commonly 
used to achieve this goal is to fade your video to, or from, black. Use the 
Speed slider to adjust the length of the fade, and then drag the Fade In 
transition to the left of (or the Fade Out transition to the right of) a clip in 
the clip viewer. Fades are also most common at the beginning or end of 
a movie. 

• Use transitions to make your subject magically appear 
o You can use a dissolve transition between clips to have your subject 

appear as if by magic. For example, with your camcorder on a tripod, 
capture video of someone in a room. Then stop recording and have the 
person leave the room. Without moving your camcorder, capture more 
footage of the empty room. You can edit these clips together in iMovie 
with a dissolve to have your subject appear and disappear from the 
scene! 
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• While your transition renders 
o You can keep working in iMovie while you transitions are being created 

or updated. You just won’t be able to play the full transition until it has 
completed rendering. 

• How two-clip transitions affect your movie length 
o Most two-clip transitions shorten the overall length of your movie 

because a transition between two clips combines part of each clip. For 
example, if you add a two-second cross-dissolve, your movie will be 
shortened by two seconds. Consider this when matching a movie’s 
length to a specific song, or when aligning scenes to specific points in 
your soundtrack, since adding a transition could affect the overall length 
of your movie. An exception is Overlap, because it uses a single frame 
from the outgoing clip as it fades in the following clip. As such, the 
overall movie length is not affected. 

• When to use a transition 
o Just because you can insert a transition between clips, don’t feel you 

must. While transitions can be a great way to add fun to a video, give it a 
soft montage-like feeling, or imply the passage of time or change of 
location, most Hollywood movies use very few transitions. While the 
most common transitions are cross-dissolves and fades, sometimes the 
best transition from one clip to another is a straight cut. 

• Have your subject push the transition 
o If you film your subject appearing to push against a wall, you can use 

this footage in combination with a Push effect so it appears that the 
subject is causing the video transition to occur in your movie. 
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Using Video Effects 

• Real-time video effects 
o Certain video effects will allow you to edit and preview them in real time, 

without waiting for rendering. You can also make changes and see them 
instantly. They render in the background and leverage your computer’s 
GPU to accelerate the process to save time for saving and exporting.  
These effects are listed under the category Quartz Composer. Note that 
the ability to use these effects in real time depends on the capabilities of 
your computer. 

• Apply an effect to part of a clip 
o There may be times when you want to apply an effect to only part of a 

clip. For example, in a movie about your dog, you might want to use the 
earthquake effect only when your dog walks across the floor. Use the 
crop markers, below the timeline in the Preview area, to select part of 
the clip. Then select the effect you want to add, and click the Apply 
button. The effect will be added to the selected portion of the clip. 

• Apply one effect to multiple clips 
o You can apply one effect to multiple clips, such as change a series of 

clips to black and white. To do this, select the first clip in the series. Then 
hold down the Command key and select the other clips. Click Apply to 
apply the same effect to all the selected clips. 

• Deleting a video effect 
o To delete a video effect applied to a clip, select the clip and press the 

Delete key. If you have multiple effects applied to a clip, the last effect 
applied will be removed first. 

• Speed up a clip to add excitement 
o Speeding up a clip is a great way to add excitement or fun to your video. 

For example, speeding up various dancing scenes could be a good way 
to show people having fun in a wedding video. Speeding up a clip also 
helps when you wish to get an entire activity in your video, but do not 
wish to take up the actual time allotted. For example, a Congo line is a 
great candidate for being sped up. 

• Don’t overdo it with effects 
o Although effects can be a lot of fun, they can easily distract your 

audience from the subject of your movie. When adding effects to your 
movie, think about the purpose of each effect and whether applying it 
enhances or distracts from the story you’re trying to tell. 
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Using Audio Effects 

• Removing wind noise and camera hum 
o If you recorded outside on a windy day, or your camcorder records its 

own operating noise with the built-in microphone, you might hear 
unwanted noise in your video. Use the Noise Reducer effect to reduce 
any unwanted noise in your recording. 

• Obtaining clean audio 
o While iMovie 6 includes the Noise Reducer audio effect, the best way to 

end up with clean audio in your movies is to record it clean to begin with. 
For important audio recordings, consider using an external microphone 
closer to the subject, such as a lavaliere mic or a handheld mic. Also, 
always monitor any important audio recording with headphones during 
the recording process. If you’ll be recording in a noisy environment, such 
as a live music event where you’re surrounded by a noisy audience, 
consider getting noise-reduction headphones, so you can still hear the 
audio coming from the camera. 
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Adding Chapters for iDVD 

• Identifying chapter markers in the timeline 
o iMovie inserts a yellow diamond in the timeline viewer for each chapter 

marker in your project. 

• Chapter marker ordering 
o IMovie always numbers chapter markers sequentially. If you add a new 

chapter marker in front of an existing chapter marker, any following 
chapter markers are renumbered automatically. 

• Chapter markers for chapter one 
o When inserting chapter markers, don’t forget to insert a marker for 

chapter one at the beginning of your movie and give it a name. This way, 
when you add your movie to an iDVD menu, the scene selection menu 
automatically created will include your chapter one title. This is 
especially useful when recording theater shows, where each act is titled. 
Otherwise, iDVD will still insert a chapter marker, but will label the first 
chapter "Beginning," which may not be what you wanted for the title of 
your first chapter. 

• Moving video clips after setting chapter markers 
o Chapter markers are associated with a time location in your movie, not a 

specific clip. If you rearrange your movie clips after adding chapter 
markers, the chapter markers stay in their original location. As such, it’s 
best to insert chapter markers as a last step, once the flow of your movie 
has been finalized. 

• Chapter markers and iDVD 
o By creating chapter markers in iMovie, you guarantee your iDVD 

projects will have your correct chapter names and starting points. While 
iDVD can add chapter markers after the fact, they are based on elapsed 
time in your movie, not when specific scenes occur. (The default is every 
5 minutes, but you can change this number.) Chapter markers based on 
elapsed time help viewers to advance through your movie quickly, but 
are not scene-specific. Also, when you add chapter markers using iDVD, 
they’re only applied to the individual iDVD project, not the original movie 
file. For these reasons, it’s always best to add chapter markers to your 
movie when you’re making it, to ensure you can have the correct starting 
point and name for each scene. Chapter markers can also be used for 
your video podcasts. 
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Playing Your Movies on TV 

• Send your movie to your camcorder 
o If you want to share your movie with friends or family members who 

don’t have a DVD player, iMovie makes it easy to send your movie back 
to your camcorder. With your movie on a digital video tape, you can 
hook your camcorder up to your VCR and create a VHS tape, or hook 
your camcorder to your TV to watch your movie. Connect your 
camcorder to your Mac, in iMovie HD choose Video Camera from the 
Share menu, and then click Share. 

• Adding your movie to an existing iDVD project 
o If you have an iDVD project already open, you can easily add an 

additional iMovie project to it. Because iMovie projects in your movies 
folder appear as movies in the iLife Media Browser, just select one and 
drag it to an iDVD menu to add it. You can also drag the project directly 
from the Finder into an iDVD menu. 

• Use new videotape when exporting your movie 
o It is a good idea to export your movie to a new digital videotape so that 

you don’t copy over your original video footage. You never know when 
you might want to use footage you didn’t use earlier. If you find yourself 
making short movies, consider creating a master tape that contains all of 
your finished movies. 

• Add black to before or after your movie 
o Rather than showing your audience static before and after your movie, 

you can set iMovie to record a few seconds of black at the beginning and 
end of your movie. This will give your presentation a polished look. You’ll 
find this option in the Videocamera pane of the Share window. For High 
Definition movies, a minimum of 6 seconds of black is recommended. 

• Save your movie on VHS tape 
o If you want to share your movie with friends or family members who 

don’t have a DVD player, you can copy it to VHS tape. After sharing your 
movie back to your camcorder, connect your camcorder up to your 
VCR’s video and audio in connectors. Then, press Record on your VCR 
and Play on your camcorder. Viola, you have your video saved to a VHS 
tape 
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Making a Video Podcast 

• Additional options for creating video podcasts 
o iWeb and GarageBand include additional features for creating video 

podcasts, such as setting the series artist, contact email, parental 
advisory rating, and iWeb allows you to submit  your podcast to the 
iTunes Podcast Directory. 

• Posting your video podcast with .Mac 
o iWeb includes the ability to publish your site to a folder so you can copy 

your podcast files to any server of your choice. For added convenience, 
you can publish your podcast files to your .Mac account for the easiest 
way to get your podcast up and running. You can also have your 
podcast listed in the iTunes Music Store so it is easy for viewers to find. 

Taking Your Movies with You 

• Send your movie to a compatible Bluetooth phone or PDA 
o If you want to view your movies on your Bluetooth enabled cell phone or 

PDA iMovie makes it easy to transfer your creations for viewing 
anywhere. In iMovie go to the Share menu and choose Bluetooth. In the 
sheet that appears, click the Share button. Your Mac will search for any 
Bluetooth enabled devices in range, choose the device you want to send 
your movie to from the list that appears, and then click Select. On your 
cell phone or PDA accept the incoming movie, and enjoy the show. 

• Watching videos from your iPod on your TV 
o With the optional iPod AV cable, you can watch videos stored on your 

iPod on a television. Simply connect one end of the iPod AV cable to 
your TV and the other end to your iPod or iPod Universal Dock. From the 
iPod main menu, choose Videos > Video Settings, and set TV Out to On. 

• Phones and PDAs have limited space 
o Because of the limited hard disk space available on many phones and 

PDAs, you should make sure that any device you share clips with will be 
able to receive the clips. 

• Adding Bluetooth to your Mac 
o Many Apple computers come with Bluetooth technology built in. You can 

purchase Bluetooth USB Adapters for any Mac with a USB port to enable short-
range wireless data connectivity between your Mac and Bluetooth-enabled 
devices. Go to www.apple.com/store and then click the Wireless link in the Mac 
Accessory section. 


